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 Quick Guide To Using Help
The EPSON Stylus Series Help window works just like the Help windows you find in other applications. If 
you are not familiar with how Help operates, here are a few tips to get you started.

 Using the Help Buttons
There are seven buttons near the top of the Help window, as described below. You can "press" a button 
by placing the pointer on the button and clicking it with your mouse.

Contents Returns you to the main Help contents dialog box

Search Searches for information about a particular topic

Back Returns you to the previous screen

History  Displays a list of the topics you have viewed

Glossary Displays a list of glossary terms

>> Proceeds to the next topic in the browse sequence

<< Returns you to the previous topic in the browse sequence

 Terms and Functions

 Hypertext and hypergraphics are links to more information about on-screen terms, icons, and functions. 
In some cases, they also provide you with links to other related topics.

Important!      When you move the pointer over hypertext or hypergraphics, the pointer changes from an 
arrow to a pointing finger. This means you can click the text or graphics to get more information.

Hypertext

Your screen displays hypertext in green.

If you click hypertext with a dotted underline, Help displays a pop-up box that contains more information 
about that term. To close the pop-up box, click anywhere on the screen or press any key on the keyboard.

If you click hypertext with a solid underline, Help jumps directly to that topic.

Hypergraphics

Hypergraphics are on-screen icons or graphics that you click to view more information.

Three Kinds of Help
When using the printer driver menus, click the Help button at the bottom of the menu to view the Help 



window. In addition, there are two other ways to quickly learn more about a setting or option: Help Tips 
and What's This? (Windows 95 only).

Help Tips

Help Tips provide a short explanation of a setting or option. To view Help Tips, move the pointer over a 
setting or option and leave it there for a few seconds. 

What's This?

If you are using Windows 95, you can display a more detailed explanation of a setting or option by right-
clicking the item, and then clicking the Whats This? box that appears. The screen displays Help related 
only to the topic you selected.
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Main menu
Click the Main tab at the top of the driver settings window to view general printer driver options. 
Click an option in the example below for more information.



 Paper menu
Click the Paper tab at the top of the driver settings window to view the available paper options. 
Click an option in the example below for more information.



 Utility menu
Click the Utility tab at the top of the driver settings window to view the printer utilities. Click a 
utility in the example below for more information. If you use Windows 3.1, the Status Monitor 
utility does not appear.



 More Settings
On the Main menu, click Advanced and then click the More Settings button to view the most 
detailed settings available in your printer driver. Click an option in the example below for more 
information.



 Alphabetical list of printer driver topics
This list covers the buttons, settings, and displays shown on the printer driver menus. To see 
information about an item below, click that item.

All menus
About
Apply
Cancel
OK

Main menu
Advanced mode
Automatic mode
Current Settings display
Ink
Media Type
More Settings
Qality vs. Speed slide bar
Save Settings

More Settings dialog box
Color Adjustment
Finest Detail
Flip Horizontal
Halftoning
High Speed
ICM
Ink
Media Type
MicroWeave
Print Quality
Video/Digital Camera

Paper menu
Duplication Method
Orientation
Paper settings display
Paper Size
Paper Source
Printable Area

Utility menu
EPSON Status Monitor utility 
Head Cleaning utility
Nozzle Check utility



Print Head Alignment utility



 Apply
Click the Apply button to put your new settings into effect before you exit the printer driver or return to 
your application.



 OK
Click OK to exit a dialog box or the printer driver and save your settings.



 Cancel
Click Cancel to exit a dialog box or the printer driver without saving your settings.



 About
Click About to display copyright and version information about the printer driver. 



 Automatic mode
When Automatic is selected on the Main menu, the printer driver software determines the best printing 
method according to the Media Type and Ink settings you make. Be sure to choose the media you have 
loaded and specify either Color or Black ink.

If you use Automatic mode with the Media Type setting set to Plain Paper or a high/photo quality setting, 
the Quality vs. Speed slide bar appears. Select either Quality or Speed and the driver will make the 
appropriate settings for you.

See also
Advanced mode



 Quality vs. Speed slide bar
When you use Automatic mode and select Plain Paper or Photo Quality Ink Jet Paper, Photo Quality 
Glossy Film, or Photo Quality Glossy Paper as your Media Type setting, the Quality vs. Speed slide bar 
appears on the Main menu. Move the slider to the left or right depending on the type of document you are
printing and the printout results you require. The slide bar disappears if you select Advanced mode.



 Advanced mode
If you prefer to have more control over the settings, select Advanced mode. When you choose Advanced 
mode, the More Settings and Save settings buttons become active. Click the More Settings button to view
the More Settings dialog box, which includes the most detailed settings in the driver. Once you have 
selected the settings you want, click OK. You can save these settings as a group by clicking Save 
settings.

Changing settings based on the type of document you are printing

The Advanced settings list (activated when you click Advanced) contains several predefined settings that 
have been optimized for certain types of documents. Click anywhere in the box under Advanced to view 
the Advanced settings list.

Note: Be sure to select the Print Quality setting you want, the Media Type you have loaded in the printer, 
and the correct Ink setting.

See also
Saving your custom setting



 Advanced settings list
The settings available in the Advanced settings list include the following and any custom settings you 
save:

 Photo

This setting is best for printing photographs. It increases the contrast in an image. 

 Text/Graph

This setting is best for graphics-intensive documents such as charts and graphics for presentations. It 
intensifies the colors but lightens the midtones and highlights of an image.

 Video/Digital Camera

This setting is best for printing images from digital data. It increases the brightness and sharpness to 
make printed images clearer.

 Economy

This setting provides you with faster printing and saves ink. The printer uses less ink by printing fewer 
dots per character. Choose this setting for rough drafts of text only.

 ICM 

This setting provides you with color matching schemes that give you more precise reproduction of the 
colors on your screen. 

Note:  You may need to experiment with different settings until you get the output you want. Also, 
selecting ICM or Video/Digital Camera automatically sets the Ink setting to Color.

For details on making and saving custom settings, see Saving your custom settings.



 Saving your custom settings
You can save your custom settings as a group in the Custom Settings dialog box. Then you can select 
this group of settings from the Advanced settings list on the Main menu. You can save up to 10 custom 
settings.

To save your settings, follow these steps:

1. From the Main menu, click Advanced. 

2.  Click More Settings to access the More Settings dialog box if necessary make your desired 
settings..

3. Click the Save settings button. The Custom Settings dialog box appears:

4. Enter a name for your settings in the Name field (up to 16 characters). Click Save. The name you 
assigned to the settings now appears in the Advanced settings list so you can choose it whenever
you want to use these settings.

To delete a custom setting, click Save settings on the Main menu, select the setting in the Custom 
Settings dialog box, and click the Delete button.

Note:  You can not delete the predefined settings: Photo, Graph, Video/Digital Camera, ICM, and 
Economy.



 Media Type
Always match the Media Type setting with the kind of paper or other media you loaded in the printer. If the
name of your EPSON paper is not in the Media Type list, see Matching your media with the Media Type 
setting.

Note:    The availability of special media varies by country.



 Ink 
Specifies Color (CMYK) or Black ink printing. Your printer's contains cyan (blue-green), magenta, yellow, 
and black (K) ink. When you select Black on the Main menu, colors are automatically converted to 
grayscale values.

If your document includes color, choose Color. If you are printing black text only, a draft, or if you want 
colors to print as varying shades of gray, choose Black.



 Current Settings 
Displays the currently selected settings. You must click Advanced and then the More Settings button to 
change make some of the settings shown here. Other settings are on the Paper menu.



 Print Quality
The available Print Quality settings are:

 SuperFine - 1440 dpi 

This setting prints at 1440 dpi giving you the highest-quality printouts. Select this setting only when you 
use EPSON Photo Quality Ink Jet Paper, EPSON Photo Quality Glossy Film, EPSON Photo Quality 
Glossy Paper, EPSON Ink Jet Canvas Cloth, or EPSON Back Light Film as your Media Type setting. 

 Fine - 720 dpi

This setting prints at 720 dpi giving you very good-quality printouts. Select this setting when you use plain 
paper, EPSON Photo Quality Ink Jet Paper, EPSON Photo Quality Glossy Film, EPSON Photo Quality 
Glossy Paper, EPSON Ink Jet Canvas Cloth, or EPSON Back Light Film as your Media Type setting.

 Normal - 360 dpi 

This setting prints at 360 dpi giving lower print quality but higher print speed. Select this setting when you 
use plain paper, EPSON Ink Jet Transparencies, or EPSON 360 dpi Ink Jet Paper as your Media Type 
setting.

 Economy

This setting is useful for saving ink. Select this setting when you use plain paper for printing rough drafts 
of text.

Note: Not all Print Quality settings are available for all media types.

See also
Matching your media with the Media Type setting



 Media Type (More Settings dialog box)
Always match the Media Type setting with the kind of paper or other media you have loaded in the printer.
If the name of your EPSON paper is not in the Media Type list, see Matching your media with the Media 
Type setting.

Note:    The availability of special media varies by country.



 Ink (More Settings dialog box) 
Specifies Color (CMYK) or Black ink printing. Your printer's contains cyan (blue-green), magenta, yellow, 
and black (K) ink. When you select Black on the Main menu ink, colors are automatically converted to 
grayscale values.

If your document includes color, choose Color. If you are printing black text only, a draft, or you want 
colors to print as varying shades of gray, choose Black.



 Halftoning
Halftoning means using patterns of colored ink dots to precisely reproduce an image and its colors. The 
halftoning method you should choose depends on the type of image you are printing. The halftoning 
image changes to show the effect of each setting.

Select No Halftoning when printing black text only. You can not select this setting for color printing.

Select Error Diffusion when printing photographic images. To make edges and colors softer, Error 
Diffusion blends every colored dot in your image with the surrounding colored dots.

Dithering arranges dots in orderly patterns and is best suited for printing charts, graphs, and other images
that require precise, solid areas of bright colors. Select Coarse Dithering for images with limited detail 
and shading. Select Fine Dithering for images with significant detail but limited shading.

Note: The available Halftoning settings depend on the Print Quality setting and the setting you choose in 
the Advanced settings list.



 MicroWeave
MicroWeave allows your printer to generate superior output because graphics data is re-ordered and 
printed in finer increments. This technology reduces the possibility of banding, the light horizontal lines 
that can mar an image.

For best results, always leave MicroWeave on for color printing. You can turn on MicroWeave for black 
printing, but the printing time is significantly longer.

Note: MicroWeave is switched off automatically when Economy is selected as the Print Quality setting.



 High Speed
This setting activates bidirectional printing so your printer prints both left-to-right and right-to-left. High 
Speed mode speeds up printing, but you should turn it off for your highest-quality output.

Note:    If misaligned vertical lines appear when printing in High Speed mode, you may need to align the 
print heads.

See also
Print Head Alignment utility



 Flip Horizontal
This setting prints an image as it would appear in a mirror; text and graphics appear backwards.



 Finest Detail
If you select Fine - 720 dpi as the Print Quality setting, you can turn on Finest Detail to print text, solid 
graphics, and line art with very sharp edges. It may take considerably longer to print using this mode and 
it will increase your memory requirements. Additionally, you may not be able to print some larger images, 
and some patterns may not print correctly. If you experience problems printing in this mode, turn it off or 
add more memory.



 Color Adjustment
Select this setting to use the color matching and enhancement methods provided by the printer driver. 

Mode
Click in the Mode box to select one of these modes:

 Automatic
 Provides output that closely matches the original data.

 Photo-realistic
 Increases the contrast in an image. Use this setting for color photographs.

 Vivid
Intensifies the colors and lightens the midtones and highlights of an image. Use this setting for 

presentation graphics, such as charts and graphs.
Slide bars
The Color Enhancement slide bars adjust the following options in a range of -25% to +25%. Drag the 
scroll bar to the right or left with your mouse to adjust the settings. You can also type -25 to +25 in the 
boxes next to the slide bars.

 Brightness
Changes the overall lightness or darkness. 

 Contrast
Magnifies or minimizes the difference between the bright and dark parts.

 Saturation
Modifies the vividness of color. The lower the saturation, the duller the colors. The higher the 

saturation, the more vivid the colors.

 Cyan, Magenta, and Yellow
Adjusts the amount of each of the three primary colors. 

Note: When Color is selected as the Ink setting, all settings in the Color box are available. When Black is 
selected, only the Contrast and Brightness settings are available.



 Video/Digital Camera
Increases the brightness and sharpness to make images captured by video or digital camera clearer 
using EPSON's intelligent color correction feature.

When Video/Digital Camera is selected, the Color Adjustment settings are dimmed, meaning you can not 
change them.

Note:    Video/Digital Camera is only available when the Ink setting is set to Color.



 ICM
Select ICM when printing scanned photographs or computer graphics. It uses the color matching method 
provided with your operating system to automatically match the colors in your printout with the colors 
displayed on your screen.



 Paper Size
You can use any of the predefined paper sizes, or you can define a custom paper size as described 
below.

The type and amount of paper you can load varies by paper source.

There are three Paper Sources and four settings to choose from.

    Auto Sheet Feeder

    Manual Feed Slot

    Manual Feed Slot (Banner)

    Tractor Feeder

 Defining a custom paper size 

To define a custom paper size, follow the steps below.

1. From the Paper menu, click anywhere in the Paper Size box.

2. Use the arrows on the right to scroll through the list until you see User Defined. Click User 
Defined.

3. Enter the paper width and height in the User Defined Paper Size dialog box.

Note: The unit of measurement is set by your operating system. See your system documentation for 
instructions on changing the unit of measurement.

4. Click OK to use the new paper size. 



 Auto Sheet Feeder
Select the paper size you have loaded in the Sheet Feeder. Your choice are :
Type Dimensions

Letter 8-1/2 X 11 inches
Legal 8-1/2 X 14 inches
A4 210 X 297 mm
B4 257 X 364 mm
A5 148.5 X 210 mm
A4(Landscape) 297 X210 mm
B5(Landscape) 257 X 182 mm
B4(Landscape) 364 X 257 mm
Letter(Landscape) 11 X 8 1/2 inches
B3 364 X 514 mm
A3 297 X 420 mm
Super A3/B 329 X 483 mm
A2 420 X 594 mm
Ledger 11 X 17 inches
US C 17 X 22 inches
Half letter 5-1/2 X 8-1/2 inches
Executive 7-1/2 X 10 inches 
Envelope #10 4-1/8 X 9-1/2 inches
Envelope DL 110 X 220 mm    
Envelope C6 114 X 162 mm
Index Card 5 X 8 in 5 X 8 inches
Index Card 8 X 10 in 8 X 10 inches
A6 Index Card 105 X 148 mm
B5 182 X 257 mm            
User Defined 100 to 329 mm X 100 to 1117 mm, 3.94 to 16.6 inches X 3.94 to 44 inches



 Tractor Feeder
Select the paper size you have loaded in the Tractor Feeder. Your choices are:
        Type

Fanfold 10 X 11in
Fanfold 12 X 11in
Fanfold 15 X 3in
Fanfold 15 X 4in
Fanfold 15 X 4.5in
Fanfold 15 X 4 2/3in
Fanfold 15 X 5in
Fanfold 15 X 5.5in
Fanfold 15 X 5 2/3in
Fanfold 15 X 6in
Fanfold 15 X 6.5in
Fanfold 15 X 6 2/3in
Fanfold 15 X 7in
Fanfold 15 X 7.5in
Fanfold 15 X 8in
Fanfold 15 X 8.5in
Fanfold 15 X 9in
Fanfold 15 X 10in
Fanfold 15 X 10in (3 part)
Fanfold 15 X 10in (4 part)
Fanfold 15 X 10.5in
Fanfold 15 X 11in
Fanfold 15 X 11in (3 part)
Fanfold 15 X 11in (4 part)
Fanfold 15 X 11in (5 part)
Fanfold 15 X 11in (6 part)
Fanfold 15 X 12in
Fanfold 15 X 12in (4 part)
Fanfold 15 X 13in
Fanfold 15 X 13in (4 part)
Fanfold 15 X 14in
Fanfold 15 X 14in (4 part)



 Manual Feed Slot
Select the paper size you have loaded in the Manual Feed Slot. Your choices are:
Type Dimensions

Letter 8-1/2 X 11 inches
Legal 8-1/2 X 14 inches
A4 210 X 297 mm
B4 257 X 364 mm
A5 148.5 X 210 mm
A4(Landscape) 297 X210 mm
B5(Landscape) 257 X 182 mm
B4(Landscape) 364 X 257 mm
Letter(Landscape) 11 X 8 1/2 inches
B3 364 X 514 mm
A3 297 X 420 mm
Super A3/B 329 X 483 mm
A2 420 X 594 mm
Ledger 11 X 17 inches
US C 17 X 22 inches
Half letter 5-1/2 X 8-1/2 inches
Executive 7-1/2 X 10 inches 
Envelope #10 4-1/8 X 9-1/2 inches
Envelope DL 110 X 220 mm    
Envelope C6 114 X 162 mm
Index Card 5 X 8 in 5 X 8 inches
Index Card 8 X 10 in 8 X 10 inches
A6 Index Card 105 X 148 mm
B5 182 X 257 mm            
User Defined 100 to 329 mm X 100 to 1117 mm, 3.94 to 16.6 inches X 3.94 to 44 inches



 Manual Feed Slot (Banner)
Select the paper size you have loaded in the Manual Feed Slot (Banner). Your choices are:
Type Dimensions

Letter 8-1/2 X 11 inches
Legal 8-1/2 X 14 inches
A4 210 X 297 mm
B4 257 X 364 mm
A5 148.5 X 210 mm
A4(Landscape) 297 X210 mm
B5(Landscape) 257 X 182 mm
B4(Landscape) 364 X 257 mm
Letter(Landscape) 11 X 8 1/2 inches
B3 364 X 514 mm
A3 297 X 420 mm
Super A3/B 329 X 483 mm
A2 420 X 594 mm
Ledger 11 X 17 inches
US C 17 X 22 inches
Half letter 5-1/2 X 8-1/2 inches
Executive 7-1/2 X 10 inches 
Envelope #10 4-1/8 X 9-1/2 inches
Envelope DL 110 X 220 mm    
Envelope C6 114 X 162 mm
Index Card 5 X 8 in 5 X 8 inches
Index Card 8 X 10 in 8 X 10 inches
A6 Index Card 105 X 148 mm
B5 182 X 257 mm            
Long Paper 17 X 1 in    through    Long Paper 17 X 44 in (step 1 inch Length)



 Paper Source
This printer has three built-in paper sources: the sheet feeder, tractor feeder, and manual feed slot. Match
the Paper Source setting in the driver software with the actual printer paper source where you have 
loaded paper. If you plan to print on banner paper which is longer than 594 mm (length of A2 paper), 
select Manual Feed Slot (Banner).

Be sure to select the Paper Size after you have selected the Paper Source.



 Duplication Method
These settings let you specify the number of copies and the printing order.

 Entering the number of copies
To specify the number of copies, click in the Copies box and type the number you want, or click the 
arrows next to the Copies box. You can enter a number from 1 to 99.

 Choosing the Collation Method
The two additional options in the Duplication Method box are Collate and Reverse Order. Click these 
options to turn them on. A check inside the box indicates the option is turned on.

To print multiple-page documents in sets:
Turn Collate on by clicking the check box.

To print one multiple-page document so that its pages are in the right order after printing:
Click only Reverse Order.

To print one or more document sets so that each is stacked in the correct order after printing:
Click both the Collate and Reverse Order check boxes.

Note:    The above options may require additional system memory. If a memory error message appears 
and you are unable to print your document, you should increase system memory, decrease the number of
open applications, reduce the size of your document, or turn off collation and/or reverse page ordering.



Orientation
To change the orientation, click one of the following buttons on the Paper menu. The image on the left 
changes to show the orientation.

Portrait -- Print direction is short edge first, like most magazines.

Landscape -- Print direction is long edge first, like many spreadsheets.

Note:    Normally, you should select the paper orientation in your software application, not with the driver.



 Printable Area
Sets the printable area to Maximum or Centered. Centered means that your document is printed at an 
equal distance from all edges of the paper, directly in the center. Maximum means using the largest 
possible printable area of the paper, so if the minimum margins are not the same on all sides, your 
printout may shift slightly on the paper. 



 Paper settings display
The image on the left side of the Paper menu changes to reflect several of the settings you make on the 
Paper menu.



Head Cleaning utility
Cleans the color and black print heads. If the print head nozzles become clogged, print quality will decline
and you may notice faint areas or areas where dots are missing. Use this utility to ensure the nozzles are 
unclogged and delivering ink properly. Before and after using this utility, use the Nozzle Check utility to 
verify whether or not the nozzles are clogged and need to be cleaned. If the Nozzle Check utility indicates
that the heads need to be cleaned, clean the print heads. If the Nozzle Check utility indicates that the 
heads are not clean after using the Head Cleaning utility, clean the print heads again.

Note:    To avoid wasting ink, clean the print heads only if print quality declines.

Using the Head Cleaning utility
1 Make sure that no ink out lights are flashing or on.

2 Open the printer driver settings window.

3 Click the Utility tab. You see the Utility menu.

4 Click the Head Cleaning button.

5 Follow the instructions on your screen to complete the cleaning procedure.

Caution: This operation takes about 90 seconds to complete. Never turn off the printer while the pause 
light is flashing.



 Nozzle Check utility
Checks whether the print head nozzles are clogged and need to be cleaned. If the Nozzle Check utility 
indicates that they need to be cleaned, open the Head Cleaning utility from this utility and clean the print 
head nozzles.

Note: Before using this utility, make sure several sheets of paper are loaded in the print.



  Print Head Alignment utility
Aligns the print heads to print images clearly. Use this if you find that your printed image is fuzzy or 
vertical or horizontal lines in your printout are not properly aligned. 

The utility includes both black and color alignment features. 

1 Make sure the printer is on and paper is loaded in the sheet feeder.

Caution: Use paper at least 210 mm (8.27 inches) wide; for example, A4 or letter size paper loaded short
edge first. Otherwise, the print head will spray ink directly onto the platen.

2 Open the printer driver settings window.

3 Click the Utility tab. You see the Utility menu.

4 Click the Print Head Alignment button.

5 Follow the instructions on your screen to align the print head.



    EPSON Status Monitor utility
The Status Monitor utility regularly monitors the printer status when you are using Windows 95. If it 
detects a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining before or during printing. 

For details on the EPSON Status Monitor, see Using the Status Monitor(Windows 95).
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 General Printing Procedures
This section describes the basic printer driver settings you should use to get the best performance and 
output from your EPSON Stylus Series printer.

 Using Automatic Mode
When Automatic mode is selected on the Main menu, the printer software determines the best printing 
method by analyzing the print data in your print job, the Media Type setting, and the Ink setting you select.
To view the Main menu, choose Print or Print Setup from the File menu of your application program. In the
dialog box that appears click Printer, Setup, Properties, or Options. (You may have to click a combination 
of these buttons.)

Before printing, always select the correct Media Type and Ink settings.

Also, if you select Plain paper or one of the High- or Photo-quality media settings as the Media Type 
setting, the Quality vs. Speed slide bar appears in the Mode box. Move the slider to the right or left 
depending on the effect you want.



 Matching your media with the Media Type setting
Match your special media with the Media Type setting. 

              Media name         Media Type setting           Part Number
EPSON 360 dpi Ink Jet Paper     360 dpi Ink Jet Paper A4                    S041059, S041025

Letter              S041060
A3                    S041065, S041046
Super A3/B    S041066, S041047
A2                    S041078

High Quality Ink Jet Paper     Photo Quality Ink Jet Paper A4                    S041117
Letter              S041111

EPSON Photo Quality Ink Jet 
Paper

    Photo Quality Ink Jet Paper A4                    S041061, S041026
Letter              S041062
Legal              S041067, S041048
A3                    S041068, S041045
Super A3/B    S041069, S041043
B                      S041070, S041044
A2                    S041079

EPSON Photo Quality Glossy 
Paper

    Photo Quality Glossy Paper A4                    S041126
Letter              S041124
A3                    S041125
Super A3/B    S041133
A2                    S041123

EPSON Photo Quality Glossy 
Film

    Photo Quality Glossy Film A4                    S041071 
Letter              S041072
A6                    S041107
A3                    S041073
Super A3/B    S041075
B                      S041074

EPSON Ink Jet Transparencies     Ink Jet Transparencies A4                    S041063
Letter              S041064

EPSON Photo Quality Ink Jet 
Card

    Photo Quality Ink Jet Paper A6                    S041054
5 X 8                S041121
10 X 8              S041122

EPSON Iron-On Transfer Paper     Photo Quality Glossy Film Letter



EPSON Photo Quality Self 
Adhesive Sheet

    Photo Quality Ink Jet Paper A4                    S041106

EPSON Ink Jet Canvas Cloth     Ink Jet Canvas Cloth                         S041132

EPSON Ink Jet Back Light Film     Ink Jet Back Light Film A3                    S041131    
A2                    S041130

EPSON 360 dpi Ink Jet Banner 
Paper

    360 dpi Ink Jet Paper                         S041103

EPSON Photo Quality Banner 
Paper

    Photo Quality Ink Jet Paper                         S041102

Note:    The availability of special media varies by country.



 Special Printing Procedures
Generally, leaving the Mode setting on the Main menu set to Automatic provides you with the highest-
quality printout. However, there may be times when you want to make special adjustments to your image 
or document. Select Advanced as the Mode setting to get a level of control unmatched by many 
application programs.

 Using Advanced Mode
When Advanced is selected, the Advanced settings list and other settings on the More Settings dialog box
are enabled. To select a setting from the Advanced settings list, click Advanced. Then click anywhere in 
the box below Advanced, and select your setting from the list. 

Be sure to choose the Media Type and Ink settings first because they may limit what other settings are 
available. The settings you make are reflected in the Current Settings display on the Main menu. To 
change the settings, click the More Settings button to access the More Settings dialog box.

The settings available in the Advanced settings list include the following and any custom settings you 
save:

Photo

This setting is best for printing photographs. It increases the contrast in an image. 

Text/Graph

This setting is best for graphics-intensive documents such as charts and presentations. It intensifies the 
colors but lightens the midtones and highlights of an image.

Video/Digital Camera

This setting is best for printing images from digital data captured by a video or digital camera. It increases 
the brightness and sharpness to make printed images clearer.

Economy

This setting provides you with faster printing and saves ink. The printer uses less ink by printing fewer 
dots per character. Choose this setting for rough drafts of black text only.

ICM

This setting provides you with color matching schemes that give you more precise reproduction of the 
colors on your screen. 

 If you make changes after you have selected a setting from the Advanced settings list, the Advanced 
settings list shows Custom Settings. To save your custom settings as a group, follow the steps below.

Saving Your Custom Settings
You can save your custom settings as a group in the Custom Settings dialog box. Then you can select 
this group of settings from the Advanced settings list on the Main menu. You can save up to 10 custom 
settings.



To save your settings, follow these steps:

1. From the Main menu, click Advanced. 

2. Click More setting to access the More Settings dialog box if necessary make your desired 
settings.

3. Click the Save settings button on the Main menu. The Custom Settings dialog box appears:

4. Enter a name for your settings in the Name field (up to 16 characters). Click Save. The name you 
assigned to the settings now appears in the Advanced settings list so you can choose it whenever
you want to use these settings.

 To delete a custom setting, click Save settings on the Main menu, select the setting in the Custom 
Settings dialog box, and click the Delete button.

Note:  You can not delete the preset settings: Photo, Graph, Video/Digital Camera, ICM and Economy.

 See Also
General Printing Procedures
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 About the Spool Manager and Despooler
When you print a document, the EPSON Stylus Series printer driver converts the print job into a journal 
file. To quickly release your software application from the task of printing, EPSON Spool Manager sends 
this journal file to the default spool directory. The Spool Manager then assigns the journal file to the 
appropriate print queue. When the journal file reaches the front of the queue, the Spool Manager sends it 
to the EPSON Despooler and then to the target printer.

When it receives a journal file, the Despooler appears on your screen to show you the progress of the 
current journal file and to identify printer status information, such as paper out and printer off line. If you 
are using Windows 95, the Despooler also includes the Status Monitor, which provides more information 
about printer status and remaining ink.

The Spool Manager gives you control over the Despooler, print queues, and journal files. It also allows 
you to enable remote network printing.

The Spool Manager starts automatically when you select Print from your application.

Note: The screen displays the Despooler when a journal file is being sent to the printer. If you do not want
the Despooler to appear, turn off the Show Despool Popup option in the Spool Managers View Menu. 

 See Also
Spool Manager

Despooler and Status Monitor



    Spool Manager
To access the Spool Manager:

Double-click  from the Windows desktop or the EPSON program group icon in Windows. You 
see the Spool Manager Window:

The Spool Manager window displays the list of EPSON Stylus printer queues.These queues contain 
Journal files that are currently printing or waiting to be printed.

 Queues
Queues shown in normal text represent printers that are supported by the EPSON Stylus Series printing 
system. Queues shown in faint text are supported by other (conventional) Windows printer drivers.

To change the options of an EPSON Stylus print queue as described in the Queue menu Help screen, 
double-click the queue or click it once to select it and then choose an option from .

 Journal Files
The Spool Manager window displays journal files in their assigned queue. If you double-click a journal file,
the screen displays a dialog box that contains journal file information, such as file size and status. Using 
this dialog you can stop printing a file, place the file on hold, delete it, or re-queue it for later printing.

Alternatively, you can click a file once to select it and then choose an option from the Document menu

From the Spool Manager you can select:

 The Queue Menu

 The Document Menu

 The View Menu



 The Options Menu  The Help Menu



The Queue Menu
The Spool Manager Queue menu allows you to place EPSON Stylus print queues on hold, release them 
to allow journal files to be printed, and identify queues as local or remote (network printing). These 
options are described below.

 Holding or Releasing a Queue

To hold or release a queue:

1 Select the queue in the Spool Manager window.

2 Click Queue to display the Queue drop-down menu.

3 Click the Hold option on the Queue menu.

A check mark next to the Hold option indicates the queue is currently on hold. When a queue is on hold, 
the Spool Manager places a wait symbol on the printer icon next to the queue and journal files in the 
queue are not submitted for printing.

 Using the Windows Print Manager
The EPSON Despooler normally send files directly to the printer.

To schedule print jobs through the conventional Windows Print Manager:

1 In the Spool Manager window, either double-click the queue or click the queue once and then 
select the Setup option the Queue menu.

2 Select the Use Print Manager for this port option and click the OK button.

 Network Printing
The EPSON Stylus Series printing system allows you to send journal files from your workstation (the host)
to a shared directory on a network server. These files can then be printed by another (remote) workstation
set up to run the EPSON Spool Manager and the associated EPSON Stylus printer driver(s). Follow the 
steps below to set up the host and remote workstations.

To set up the host:

1 In the Spool Manager window, either double-click or click the queue once to select it and then the 
queue or select the Setup option on the Queue menu.

2 Click the Spool to remote printer button.

3 Click the Browse button and select the remote server spool directory that will receive journal files
from the Spool Manager.

To set up a remote workstation:

1 Install the EPSON Stylus Series printing system and the required printer driver(s).

2 Select the Spool Manager from the EPSON Windows program group.

3 Either double-click the queue or click the queue once to select it and then select the Setup option



on the Queue menu.

4 Select the Remote Despool tab and then click the Printing from remote queues option.

5 Click the Browse button and select the remote server spool directory that will hold journal files 
sent from host workstations.

6 The Spool Manager then identifies journal files and submits them for printing.

 See Also
Option Menu



The Document Menu
The Spool Manager Document menu allows you to control journal files in your EPSON Stylus print 
queue. Using this menu, you can hold a journal file, re-queue it for printing later, delete it, or keep it for 
subsequent re-printing.

To select any of these options for a journal file, click the journal file, click Document, and click an option 
on the Document menu. When you select a Document menu option, a check mark appears next to it. To 
turn off an option, click it again.



The View Menu
The Spool Manager View menu allows you to select the information displayed by the EPSON Spool 
Manager. Using this menu, you can also specify whether you want the EPSON Despooler pop-up window
to appear when you select Print from your application. When you select a View menu option, a check 
mark appears next to it. To turn off an option, click it again.

If you turn off the Show Despool Popup option, the Despooler window normally does not appear when 
you send a print job to the printer. It does appear, however, if the printer reports an error such as paper 
out.



The Options Menu
The Spool Manager Options menu allows you to specify the default spool directory, set the timers, and 
select the font used in the Spool Manager window.

 Default Spool Directory
Choose this option to change the default spool directory setting. Journal files will be sent to this directory 
instead of the TEMP directory. This option is equivalent to the Spool Directory setting in the Queue Menu 
Setup option except that it applies to all queues instead of only the selected queue.

 Timers

Using the Timers Setup box, you can set the update and/or remote timers.

Update Timer

The Update Timer tells the Spool Manager how often to refresh the information displayed in the EPSON 
Spool Manager window.

Remote Timer

The Remote Timer tells a remote Spool Manager how often to look for new journal files in a network 
directory.

See the Queue Menu for more information about network printing.

 Font
The Font option allows you to set the default font used to display information in the Spool Manager 
window. All of your installed Windows fonts are available. This option also allows you to select bold and/or
italics and specify the print size.

 See Also
Queue Menu



The Help Menu
The Spool Manager Help menu allows you to access Spool Manager Help as well as copyright and 
version information.



 Despooler and Status Monitor
When you print a file in your application, the Despooler window appears on your screen. You see:

Note: The Status Monitor (shown at the bottom of the screen) appears only if you are using Windows 95 
with a local printer.

Use the Despooler window for:

 Controlling Journal Files  Viewing Printer Status.

 Using the Status Monitor (Windows 95) 



 Controlling Journal Files
The EPSON Despooler lets you control printing the same way you can control it using the Document 
menu of the EPSON Spool Manager.

 Buttons
The following buttons allow you to:

 Stop -- Cancel printing.

 Pause -- Pause printing until you click it again.

 Reprint -- Restart printing from the current page or reprints the document.

 About and Help
Clicking the Help button displays the Despooler and Status Monitor Help screen. Clicking the About 
button displays copyright and version information about the EPSON Despooler.

 See Also
Spool Manager



 Viewing Printer Status 

The icon in the upper right of the Despooler window indicates how much of the current page has been 
printed. The Despooler divides each page of the document into one or more horizontal bands for 
processing. After the Despooler sends a band to the printer, it starts to process the next band. If your 
document is very simple, there may be only one band per page. If your document is complex (for 
example, if it contains graphic images) or if your computer has little free memory, there may be many 
bands per page.

The Despooler window displays printer status messages above the printer icon.

If an error occurs, the Despooler automatically continues the print job as soon as the problem is fixed.    If 
a serious error occurs, such as printer power failure, you may need to re-queue the journal file using the 
Document Menu Requeue option.



 Using the Status Monitor (Windows 95)
If you are using Windows 95 and your computer system is equipped with a bidirectional parallel port and a
suitable interface cable, the lower portion of the Despooler window displays the Status Monitor:

The Black Ink and Color Ink level indicators provide a graphical representation of the amount of ink in 
the cartridges. As you use up ink, the indicator drops in 25% (quarter) increments. When the level drops 
to 20%, the indicators change from green to yellow. When the level drops to 10% or less, the indicator 
changes to red.

The printer icon in the Status Monitor changes depending on the printer's status. The printer icons convey
the following messages:

The Status Monitor is checking the printer status.

An error has occurred, and your printer cannot print. Check your printer and then resend the print job.

The printer is ready.

The printer is printing.

The ink level is low or the cartridges are empty.

Note: This feature is not available for printers connected on a network.



    Automatic Error Reporting
Even if you have turned off Show Despool Popup on the View Menu of the Spool Manager, the EPSON 
Despooler pops up when errors occur, such as paper out and printer off line.
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About button
The About button appears in the printer driver settings window. Clicking this button displays copyright and 
version information about the software you are using.



Additive colors
Colors that are produced by adding together the varying intensities of the three primary colors: red, green,
and blue. This is how your screen works.



More Settings dialog box
The More Settings dialog box provides you with the most detailed settings available in your printer driver. 
See the following for more details on the settings in this dialog box: Color Adjustment, Video/Digital 
Camera, ICM, Halftoning, Ink , High Speed, Finest Detail, Flip Horizontal, Print Quality, and Media Type.

To access the Advanced dialog box, click Advanced and then click More Settings on the Main menu.



Apply button
The Apply button appears on several menus. Clicking this button puts your new settings into effect before 
you exit the printer driver or return to your application.



Automatic (Color Adjustment mode)
The Automatic option in the Color Adjustment mode list uses the printer drivers color matching scheme to 
match the colors in your printout with the colors on your screen.



Automatic Mode
When Automatic is selected on the Main menu, the printer driver software automatically optimized the 
settings according to the Media Type, and Ink settings.

Be sure to choose the media you have loaded and specify either Color or Black ink.



Bidirectional parallel port
A port that allows data to flow back-and-forth between your computer and printer. A bidirectional parallel 
port is needed for your EPSON Stylus printer to send special information to your computer. See your 
computer documentation (or ask your dealer) to determine if your computer is equipped with a 
bidirectional parallel port.

Most computer systems come with a bidirectional (PS/2 type) parallel port that meets IEEE 1284 
Standards. If your system is not equipped with this type of port, you can purchase a bidirectional parallel 
interface card from your computer dealer.



Bidirectional printing
A method of printing where the print heads print in both directions, increasing print speed. The High 
Speed setting on the Main Menu enables this type of printing.



Brightness
The slide bar that controls the lightness or darkness of an image. You can adjust this option in the More 
Settings dialog box. If this option is dimmed (meaning unavailable), click Color Adjustment and then make
the Brightness setting.



Browse sequence
A way to view help information that allows you to proceed from one topic to another in a predetermined 
order. Click the >> button near the top of the Help window to follow the browse sequence.

The browse sequence in the EPSON Stylus Help window includes information on how to use the most 
important features of your printer driver.



Cancel button
The Cancel button appears at the bottom of the printer driver settings window and dialog boxes. Click the 
Cancel button to exit the printer driver or a dialog box without applying or saving any changes.



 CMYK
Cyan - Magenta - Yellow - BlacK.

The three primary process (subtractive) colors plus black. Your printer produces a full range of colors by 
mixing CMYK.



Coarse Dithering
A Halftoning setting in the More Settings dialog box for photographic images or equivalent drawings. This 
Halftoning setting is best used for images with limited detail and shading.



Collate
A Paper menu option that allows you to collate (sort) copies of a multi-page document into individual sets 
of that document.



Color box
This box on the More Settings dialog box contains three settings; Color Adjustment, Video/Digital 
Camera, and ICM. You can select one of these settings as a method of modifying or matching color.



Color Adjustment 
The software provided with your printer driver allows you to enhance the color in your printout. This 
includes three adjustment modes; Automatic, Vivid, and Photo-realistic. It also includes several slide bars 
to further help you control the color output; Brightness, Contrast, Saturation, Red, Green, and Blue. You 
can adjust Brightness and Contrast whether Ink    is set to Color or Black, but you can only adjust the 
other options if Ink is set to Color.

To make Color Adjustment settings, open the More Settings dialog box then click anywhere in the Mode 
box to select an adjustment mode and click and drag the slide bar arrows to increase or decrease an 
options strength.



Color matching
Color matching is the process of matching colors in your printout with the colors that appear on your 
screen. You can select a color matching option from the Color box area in the More Settings dialog box. 
The Automatic option in the Color Adjustment Mode list contains the color matching software provided 
with your printer driver and ICM is the software provided by your operating system.



Contrast
Contrast means the degree of difference between the darkest and lightest areas in an image. The higher 
the contrast, the greater the difference. You can adjust the Contrast value in the More Settings dialog box.



Copies
This is the number of times you want a document to be printed. The default value is 1.You can enter a 
different value on the Paper menu, but you should normally specify the number of copies using the Print 
function of your application.



Current Settings display
The Current Settings display shows which settings are currently enabled or disabled. To change a setting 
shown here, you will have to click the Paper tab to access the Paper menu, or you will have to click the 
Advanced button and then the More Settings button to access the More Settings dialog box. 



Custom Settings (Advanced settings list)
Custom Settings means that the current settings have been made by you, the user. The Advanced 
settings list shows Custom Settings if you click the Advanced button and customize the settings on your 
own or if you select a predefined setting in the Advanced settings list and then make other settings on 
your own. Any time the Advanced settings list shows Custom Settings, you can save those settings as a 
group in the Custom Settings dialog box. 



Custom Settings dialog box
If you change settings after you have selected the Advanced mode, the Advanced settings list shows 
Custom Settings. If you want to save your custom settings as a group, click Save settings. The Custom 
Settings dialog box appears. After typing a unique name in the Name box, click Save. You can save up to 
10 settings, and these settings will appear in the Advanced settings list on the Main menu.



Default Spool Directory
The directory to which print data is sent as part of the first step in the printing process. This directory is 
normally specified by the DOS environment string SET TEMP= in your CONFIG.SYS file.

You can change the default spool directory by selecting Default Spool Directory from the Options menu
in the EPSON Spool Manager.



Despooler
The name of the software that takes the journal files from the Spool Manager and sends them to the 
printer. The Despooler window appears on your screen when it receives a journal file, and allows you to 
stop, pause, or reprint the file. It also displays printer status information. If you are using Windows 95, the 
Status Monitor appears at the bottom of the Despooler window.



Document menu (Spool Manager)
A drop-down menu in the Spool Manager that allows you to hold print jobs, save them for reprinting, 
delete them from the queue, or re-order them for later printing. 



dpi
Dots per inch. The number of dots your printer can print in one inch distance in both the horizontal and 
vertical dimensions. If you double the dpi, you increase the total number of dots by a factor of four. 
Resolution is measured in dpi.

Note:    The Print Quality options do not necessarily yield the same resolutions in both the vertical and the
horizontal directions.



Economy (Print Quality option)
A Print Quality option in the More Settings dialog box that saves ink. This mode is best for printing rough 
drafts of text on plain paper.



EPSON Status Monitor utility
The Status Monitor utility regularly monitors the printer status when you are using Windows 95. If it 
detects a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining before or during printing. 

To use the Status Monitor, click the Utility tab in the printer software window and double-click the EPSON 
Status Monitor icon. 



EPSON Stylus Printing System
A term used to describe the EPSON Stylus series printer, printer driver, Spool Manager, and Despooler, 
which includes the Status Monitor for Windows 95.



EPSON Stylus series printer driver
A printer driver is the software that runs, or drives, your printer. You can access the printer driver by 
clicking Print or Print Setup on the File menu in your application or by clicking the Printers icon in Control 
Panel.



Error Diffusion
A Halftoning setting in the More Settings dialog box for photographic images or equivalent drawings. This 
is the highest quality but slowest halftoning setting. It blends the colored dots in your image with the 
surrounding colors to soften your image.



Fine - 720 dpi (Print Quality option)
A Print Quality option that produces almost photographic-quality output at a slower speed and at 720 dpi 
resolution. This mode is best when used with special media such as glossy paper, glossy film, and ink jet 
paper.

You can use Fine - 720 dpi for Black or Color printing.



Fine Dithering
A Halftoning setting in the More Settings dialog box for some photographic images, drawings, or detailed 
presentations. This Halftoning setting is best used for images with a lot of detail but limited shading.



Finest Detail
If you select Fine - 720 dpi as the Print Quality setting, you can turn on Finest Detail to print text, solid 
graphics, and line art with very sharp edges. Be aware that it may take considerably longer to print using 
this mode and it will increase your memory requirements. Additionally, you may not be able to print some 
larger images, and some patterns may not print correctly. If you experience problems printing in this 
mode, turn it off or add more memory.



Flip Horizontal
This setting prints an image as it would appear in a mirror; text and graphics appear backwards.

If your application program does not automatically flip images for iron-on transfers, use this feature.(U.S.A
only)



Font option (Spool Manager)
An option on the Options menu in the Spool Manager used to change the Spool Manager window font.



Halftoning
Process of using tiny dot patterns to represent all the colors you see in an image. Halftoning provides 
better graphic printouts, but slows down printing. From the More Settings dialog box, you can select the 
following Halftoning settings (depending on the Print Quality, Media Type, and Ink settings you make): No 
halftoning, Coarse Dithering, Fine Dithering, and Error Diffusion.

Select No Halftoning when printing text only.



Head Cleaning utility
Cleans the color and black print heads. If the print head nozzles become clogged, print quality will decline
and you may notice faint areas or areas where dots are missing. Use this utility to ensure the nozzles are 
unclogged delivering ink properly. Before and after using this utility, use the Nozzle Check utility to verify 
whether or not the nozzles are clogged and need to be cleaned. If the Nozzle Check utility indicates that 
the heads need to be cleaned, clean the print heads. If the Nozzle Check utility indicates that the heads 
are not clean after using the Head Cleaning utility, clean the print heads again.



Help Button
Click the Help button to display the EPSON Stylus Help window.



High Speed
This setting activates bidirectional printing mode so your printer prints both left-to-right and right-to-left. 
High Speed mode speeds up printing, but you should turn it off for the highest quality output.



Holding option (Spool Manager)
An option on the Queue menu in the Spool Manager that allows you to hold or release a Queue.



ICM
Select ICM when printing scanned photographs or computer graphics. This setting uses the Windows 95 
color matching method to automatically match the colors in your printout with the colors displayed on your
screen. Be aware that the ambient light and the age, quality, and settings of the monitor can affect the 
quality of your color matching.



Ink cartridge
The plastic, replaceable ink container. You can check the level of ink remaining with the Status Monitor. 

When the ink out lights flash, prepare a replacement ink cartridge. When the ink out lights are on, replace 
the empty ink cartridge with the replacement ink cartridge. Most EPSON Stylus Series printers use one 
color (CMY) ink cartridge and one black ink cartridge. See Troubleshooting in the Help window for details 
on replacing an ink cartridge.



Ink Jet Paper
Special coated paper used for high quality printing at 360 dpi. Use this paper in Normal - 360 dpi or Fine 
- 720 dpi mode when you print detailed images.



Ink Jet printer
A printer that prints each letter, symbol, or image by precisely spraying ink onto paper.



Ink setting
The two ink setting are Color (CMYK) and Black . You can make this setting on the Main menu or in the 
More Settings dialog box. 

Choose Color if your printout includes color. Choose Black if you are printing black text only, a draft, or if 
you want colors to print in varying shades of gray.



Journal file
A compact file that the EPSON Stylus Series printing system generates to provide a complete description 
of your print job in a form that can be processed easily and quickly. A journal file is similar to a tape 
recording in that it can be played, replayed, or played back-to-front (Reverse Page Order).



Landscape
An Orientation setting on the Paper menu that produces a document where the top and bottom edges 
are longer than the side edges. This setting is best for printing wide spreadsheets and presentations.



Main menu
This is the menu in the printer driver that provides the most common driver settings. See the following for 
more details about the settings available on this menu: Automatic, Advanced, More Settings, Save 
Settings, Media Type, Ink, and Custom Settings display.



Advanced mode
If you prefer to have more control over the settings select Advanced mode. When you choose Advanced 
mode, the More Settings and Save settings buttons become active. Click the More Settings button to view
the More Settings dialog box, which includes the most detailed settings in the driver. Once you have 
selected the settings you want and clicked OK, you can save them as a group by clicking Save Settings.

Changing Settings Based on the Type of Document you are printing

The Advanced settings list (activated when you click Advanced) contains several predefined settings that 
have been optimized for certain types of documents. Click anywhere in the box under Advanced to view 
the Advanced settings list.

Note: Be sure to also select the Print Quality setting you want, the Media Type you have loaded in the 
printer, and the correct Ink setting.



Advanced settings list
The settings available in the Advanced settings list include the following predefined settings and any 
Custom Settings you save:

Photo, Text/Graph, Video/Digital Camera, Economy, and ICM.



Media
The type of materials on which data is printed such as envelopes, plain paper, ink jet paper, and 
transparency film.



Media Type
The Media Type setting is included on the Main menu and in the More Settings dialog box for your 
convenience. You can choose any of the following Media Type options: Plain paper, Ink Jet Paper, Photo 
Quality Ink Jet Paper, Photo Quality Glossy Paper, Photo Quality Glossy Film, Ink Jet Transparencies, Ink
Jet Back Light Film, Ink Jet Canvas Cloth



Ink Jet Canvas Cloth
Special media which has a canvas-cloth like texture and is designed to give an oil-painted artistic 
impression to printed images.



Ink Jet Back Light Film
Special media which has a frosted-glass like printable surface and a glossy surface on its reverse side. 
Printing on this film gives a crisp, translucent image for use in back-lit displays.



MicroWeave
MicroWeave allows your printer to generate superior output because graphics data is re-ordered and 
printed in finer increments. This technology reduces the possibility of banding, the light horizontal lines 
that can mar an image.

For best results, always leave MicroWeave on for color printing. When you have the option you can turn 
on MicroWeave for black printing, but the printing time is significantly longer.

Note: MicroWeave is switched off automatically when Economy is selected as the Print Quality setting.



Network printing
Your EPSON Stylus Series printer is designed so it can be used on a network.

See also the Spool Manager and Despooler.



Normal - 360 dpi (Print Quality option)
A Print Quality option that prints at 360 dpi (dots per inch). This option produces fair print quality but the 
print speed is much quicker than Fine - 720 dpi or SuperFine -1440 dpi. Select this setting and use plain 
paper, EPSON Ink Jet Transparencies, or EPSON 360 dpi Ink Jet Paper for regular printouts.



Nozzle Check utility
Checks whether the print head nozzles are clogged and need to be cleaned. If the Nozzle Check utility 
indicates that they need to be cleaned, open the Head Cleaning utility from this utility and clean the print 
head nozzles.

Note: Before using this utility, make sure several sheets of paper are loaded in the print.



OK Button
Click the OK button at the bottom of the driver settings window to save all your setting changes and exit 
the printer driver.



Options Menu (Spool Manager)
A drop-down menu in the Spool Manager that allows you to change the Default Spool Directory, set 
timers, and select the default font for the Spool Manager window.



Orientation
A setting on the Paper menu that allows you to choose the orientation of print on your printout: Portrait or
Landscape. In portrait orientation, the top of the page is parallel with the short edge of the paper. 
Landscape images are printed with the top of the page parallel to the long edge of the paper. The 
Landscape option is ideal for printing wide spreadsheets. The default setting is Portrait.



Paper menu
This menu provides settings that control or affect how paper is used in the printing process. See the 
following for more details about the settings available on this menu: Paper Size, Paper Source, Copies, 
Collate, Reverse Order, Orientation, Printable Area, and the paper settings display.



Paper settings display
The image on the left side of the Paper menu changes to reflect several of the settings you make on the 
Paper menu.



Paper Size
A Paper menu setting used to specify the size of the paper loaded in your printer. 



Paper Source 
This printer has three built-in paper sources: the sheet feeder, tractor feeder, and manual feed slot. Match
the Paper Source setting in the driver software with the actual printer paper source where you have 
loaded paper. If you plan to print on banner paper which is longer than 594 mm (length of A2 paper), 
select Manual Feed Slot (Banner).



Photo Quality Glossy Film
Special coated film for ink jet printers that gives you the best image quality.



Photo Quality Glossy Paper
Special coated paper for ink jet printers that gives you the best picture quality.



Photo Quality Ink Jet Paper
Special coated paper used for very high quality printing at 720 dpi or 1440 dpi. Use this paper in Fine - 
720 dpi or SuperFine - 1440 dpi mode when you print your most important work.



Portrait
An Orientation setting on the Paper menu that produces a document where the top and bottom edges are
shorter than the sides. This is the most common orientation setting and is selected by default. 



Predefined settings
Predefined settings are groups of settings that are provided for specific purposes. These settings can be 
found by clicking the Advanced button and clicking anywhere in the Advanced settings list on the Main 
menu. 



Printer driver
A printer driver is software that runs, or "drives," your printer.



Print Head Alignment utility
Aligns the print heads to print images clearly. Use this if you find that your printed image is fuzzy or 
vertical or horizontal lines in your printout are not properly aligned. 

This utility includes both black and color alignment features. 



Print Quality
The available Print Quality settings are: SuperFine - 1440 dpi, Fine - 720 dpi, Normal - 360 dpi, and 
Economy.



Queue(s)
A queue is a list of journal files that are currently printing or waiting to be printed. Queues are always 
associated with a local or remote (across a network) print device.

The EPSON Spool Manager displays your printer name and the associated queue. It also displays an 
icon representing your print device. The Spool Manager places a wait symbol on the appropriate printer 
icon when the queue is on hold or paused. You can hold a queue using the Hold command on the Queue 
menu.



Queue menu (Spool Manager)
A drop-down menu in the Spool Manager that allows you to place the selected queue on hold, allows you 
to release a held queue so that its journal files are printed, and identifies if a queue is local or remote.



Release time
The time it takes to regain control of your application after you send a print job to the printer. The EPSON 
Stylus Series printing system quickly processes the print job and then releases your application so that 
you can continue working while your printer is printing.



Releasing a queue
To release the journal files you placed on hold and cause the printer to print them, turn off the Hold option 
on the Queue Menu in the Spool Manager. 



Reverse Order
A Paper menu option that allows you to print your multi-page document from the last page to the first. If 
you select Reverse Order, your document will be in normal reading order when it is finished printing. 
When Reverse Order is off (the default setting), your document is printed in order from the first page to 
the last.



Spool Manager
The Spool Manager is software used by the printer driver to facilitate printing. When you print a document
from your application, the printer driver use the Spool Manager to send the data to the Despooler and 
then to the printer. This releases your computer quickly so that you can continue using your application 
and allows printing to take place in the background.



SuperFine - 1440 dpi (Print Quality option)
A Print Quality setting that produces photographic-quality output at a slower speed and at 1440 dpi 
resolution. Select this setting for your most important work. SuperFine - 1440 dpi works best when used 
with special media such as glossy paper, glossy film, and ink jet paper.

You can use SuperFine - 1440 dpi for Black or Color printing.



Timers option (Spool Manager)
An option on the Option menu in the Spool Manager that allows you to set two timers: the Update Timer 
and the Remote Timer.

The Update Timer tells the Spool Manager how often to refresh the information it displays. 

The Remote Timer tells a remote Spool Manager how often to look for new journal files in a network 
directory.



Transparencies
Specially prepared transparency film for use on overhead projectors. We recommend the use of EPSON 
transparency film, which is specifically designed for use with ink jet printers.



Utility menu
This menu provides utilities that give you printer status information and help you maintain your printer. 
See the following for more details about the utilities available on this menu: Print Head Alignment, Head 
Cleaning, Nozzle Check, and EPSON Status Monitor.



Video/Digital Camera
Increase the brightness and sharpness to make images captured by video recorder or digital camera 
clearer using EPSONs intelligent color collection feature.

When Video/Digital Camera is selected, other Color settings are dimmed, meaning you can not change 
those settings.



View menu (Spool Manager)
A drop-down menu in the Spool Manager that allows you to select the information displayed by that the 
Spool Manager. Using this menu, you can also choose to keep the Despooler from appearing when you 
print.



Windows GDI
Graphics Device Interface (GDI). The part of the Microsoft Windows environment that allows 
programmers to draw lines, circles, polygons, and text and control other graphics elements on the output 
device (for example the screen, printer, or plotter, and so on).



WYSIWYG
What You See Is What You Get. Generally with the EPSON Stylus series printing system, what you see 
on the screen is what you get in your printout in terms of colors, image size, and print density.
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 Printing Supplies
 EPSON Special Media list

EPSON Special coated paper for 360 dpi printing (A4) S041059, S041025
EPSON 360 dpi Ink Jet Paper (A4) S041059, S041025
EPSON Special coated paper for 360 dpi printing (Letter) S041060
EPSON 360 dpi Ink Jet Paper (Letter) S041060
EPSON Special coated paper for 360 dpi printing (A3) S041065, S041046
EPSON 360 dpi Ink Jet Paper (A3) S041065, S041046
EPSON Special coated paper for 360 dpi printing (Super A3/B) S041066, S041047
EPSON 360 dpi Ink Jet Paper (Super A3/B) S041066, S041047
EPSON Special coated paper for 360 dpi printing (A2) S041078
EPSON 360 dpi Ink Jet Paper (A2) S041078

EPSON Special coated paper for 720 dpi printing (A4) S041061, S041026
EPSON Photo Quality Ink Jet Paper (A4) S041061, S041026
EPSON Special coated paper for 720 dpi (Letter) S041062
EPSON Photo Quality Ink Jet Paper (Letter) S041062
EPSON Special coated paper for 720 dpi printing (Legal) S041067, S041048
EPSON Photo Quality Ink Jet Paper (Legal) S041067, S041048
EPSON Special coated paper for 720 dpi printing (A3) S041068, S041045
EPSON Photo Quality Ink jet Paper (A3) S041068, S041045
EPSON Special coated paper for 720 dpi printing (B) S041070, S041044
EPSON Photo Quality Ink jet Paper (B) S041070, S041044
EPSON Special coated paper for 720 dpi printing (Super A3/B) S041069, S041043
EPSON Photo Quality Ink jet Paper (Super A3/B) S041069, S041043
EPSON Special coated paper for 720 dpi printing (A2) S041079
EPSON Photo Quality Ink jet Paper (A2) S041079

High Quality Glossy Paper (A4) S041071
EPSON Photo Quality Glossy Film (A4) S041071
High Quality Glossy Paper (Letter) S041072
EPSON Photo Quality Glossy Film (Letter) S041072
EPSON Photo Quality Glossy Film (A6) S041107
High Quality Glossy Paper (A3) S041073
EPSON Photo Quality Glossy Film (A3) S041073
High Quality Glossy Paper (B) S041075
EPSON Photo Quality Glossy Film (B) S041075
High Quality Glossy Paper (Super A3/B) S041074
EPSON Photo Quality Glossy Film (Super A3/B) S041074



EPSON Photo Quality Glossy Paper(A4) S041126
EPSON Photo Quality Glossy Paper(Letter) S041124
EPSON Photo Quality Glossy Paper (A3) S041125
EPSON Photo Quality Glossy Paper (Super A3/B) S041133
EPSON Photo Quality Glossy Paper (A2) S041123

Transparency Film (A4) S041063
EPSON Ink Jet Transparencies (A4) S041063
Transparency Film (Letter) S041064
EPSON Ink Jet Transparencies (Letter) S041064

Special coated index cards for 720 dpi (A6) S041054
EPSON Photo Quality Ink Jet Cards (A6) S041054
EPSON Photo Quality Ink Jet Cards (5 X 8) S041121
EPSON Photo Quality Ink Jet Cards (10 X 8) S041122

EPSON 360 dpi Banner Paper S041103
EPSON 360 dpi Ink Jet Banner Paper S041103
EPSON 720 dpi Banner Paper S041102
EPSON Photo Quality Ink Jet Banner Paper S041102

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Canvas Cloth S041132

EPSON Ink Jet Back Light Film (A3) S041131
EPSON Ink Jet Back Light Film (A2) S041130

Note:    The availability of special media varies by country.

EPSON Ink Cartridge
Black ink cartridge S020108
Color ink cartridge S020089
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 Power Supply
The lights come on briefly but then go off and stay off.

The printer's voltage rating may not match the voltage of your electrical outlet.

 Check the printer and outlet voltage ratings. If the voltages do not match, unplug the printer immediately 
and contact your dealer.

 Warning: Do not reconnect the power cord to an electrical outlet that does not have matching voltage.

The printer does not work and the control panel lights are off. 

The printer is turned off.

 Press the Operate button.

The power cord is not properly plugged into the electrical outlet.

 Turn off the printer, make sure the power cord is firmly plugged into the electrical outlet, and turn the 
printer back on. If the lights still dont come on, contact your dealer.

The electrical outlet is controlled by an outside switch or automatic timer.

 Use a different outlet.

The electrical outlet is out of order.

 Plug another electric device into the outlet to determine whether the outlet is working. If it is not, use a 
different outlet. 



 Operation
The Operate light is on but nothing prints.

The interface cable is not plugged in securely.

 Confirm that the cable is securely fastened to the printer and the computer. If the cable is connected 
correctly, run a self test.

Your interface cable does not meet the printer or computer specifications. 

 Use an interface cable that meets both printer and computer specifications.

Your software is not properly set up for your printer. 

 Make sure that your printer is selected in your software. Install or reinstall the printer software.

One or both ink cartridges may be too old. They are too old if they have been used longer than six months
or beyond the date on their packaging.

 First try cleaning the print heads. If print does not appear, you may need to replace the cartridge.

Nothing prints and the control panel lights are on or flashing.

Several common printer errors have occurred.

 Refer to the printer users guide to determine what combination of errors may have occurred, and apply 
the recommended solutions.

The printer sounds like it is printing but nothing prints.

The print head nozzles are clogged.

 Clean the Print Heads.

One or both of the ink cartridges have been used longer than six months or beyond the date on the 
packaging.

 Try cleaning the print heads. If that does not solve the problem, replace the ink cartridges as needed.

The self test prints well, but nothing prints from an application.

Your printer is not selected in your application program.

 Select your printer in the printer setup section of your application. 

The interface cable does not meet the printer or computer specifications.

 Use a printer cable that meets both printer and computer specifications.



Your computer is not 100% IBM AT compatible.

1.    For Windows 95: Click Start, point to Programs and Epson, and then click Spool Manager4. For 
Windows 3.1: Open the EPSON program group and double-click Spool Manager4.

2.    Select your printer and click Setup on the Queue menu. Turn on the Use Print Manager for this port 
option in the Queue Setup window and send your print data. If it does not print properly, turn off Use Print 
Manager for this port and try printing again.

Your computer systems memory is not sufficient enough to handle the volume of data in your document.

 Reduce the image resolution of your document in your image-editing application or the printer software.

 Install more memory if necessary. 

 If you are unable to print after trying the above solutions, lower the screen resolution or use less colors 
on your display. The directions below tell you how to access the display-adapter options for Windows 95 
and 3.1.

 For Windows 95: Choose a lower resolution setting as the Color Palette setting. To access the Color 
Palette, click Start, point to Settings, and choose Control Panel. Then double-click the Display icon and 
click the Settings tab. For detailed information on making this setting, see your Windows 95 user's guide.

 For Windows 3.1: Double-click the Windows Setup icon on the Main Menu and click Options and choose 
Change System Setting. Then lower the screen resolution using the Display pop-up list. For detailed 
information on making this setting, see your Windows 3.1 user's guide.

 If you have a display-adapter setting utility, use it to lower the screen resolution. For detailed information, 
see your display board user's guide. 

Color documents print out in black and white.

Your printer is not selected in your application program.

 Select your printer in your application by clicking Print on the File menu and in the dialog box that 
appears, select your printer from the list of printers. Depending on your application, you may also have to 
click Printer, Options, Properties, or Setup before you can select your printer.

Color printing is not selected in your application or in the printer driver.

 Select color printing in your application and the driver. Try to print again. If the image still comes out in 
black and white, try printing from another program. If this fixes the problem, contact the manufacturer of 
the software you had trouble with.

The printer is being used with an empty color ink cartridge installed.

 Replace the color ink cartridge, then turn the printer off and back on. Be aware that any data sent to the 
printer will be lost.

Printing starts too high or too low on the page.

Margins are set incorrectly in your application.



 Check that the margins are set correctly in your program.

The size of the paper loaded in the printer does not match the paper size setting within your application or
printer driver.

 Load the correct size of paper, or change the paper size settings within your application or printer driver 
to match the size of the paper you are using.

Print speed is not what you expect.

The image resolution and the amount of color used in the document may be too high.

 Carefully considering your use of color and resolution can help you optimize your printing times. 

Note: High resolution printing and color printing significantly increase the amount of data to be processed.
These two factors have the greatest effect on print speed.

Something on the page is wrong or missing.

An unknown problem has occurred.

 Disconnect the interface cable from the computer; then try a self test.

The printer settings within your application are incorrect.

 Adjust the printer settings within your application and print again.

The interface cable is not plugged in securely.

 Check that the cable is securely connected to the printer and the computer.

The data transfer rate does not match that of your computer.

 Set the Parallel I/F mode to Normal in the default-setting mode.

Application program settings are overriding those made in the default-setting mode.

 Always try making a setting in your application first. If that is not possible, use the printer driver. If that is 
also impossible, use the default-setting mode. 

The Status Monitor window does not appear when you are using Windows 95.

The Use Print Manager for this port option is checked in the Queue Setup window. 

Make sure Use Print Manager for this port is not checked. Click the Start button, point to Programs, point 
to Epson, and click Spool Manager4. Then click Queue and Setup in the EPSON Spool Manager window.

The Enable bi-directional support for this printer option is not selected in the Spool Settings window.

 You must select Enable bi-directional support for this printer in the Spool Settings window to use the 



Status Monitor. To access the Spool Settings window, click the Start button, point to Settings, and click 
Printers. Right-click the icon for your printer and choose Properties from the drop-down menu. Click the 
Details tab; then click Spool Settings. Select Enable bi-directional support for this printer.

Line spacing is incorrect

The line-space setting in your software is wrong.

 Adjust the line-space setting with your software.

The typestyles or characters set with your software do not print.

Your software is not correctly configured.

 Make sure that your software is correctly configured for your printer.



 Paper Handling
Single sheets do not feed properly from the sheet feeder.

Too many sheets may be loaded in the sheet feeder.

 Remove the paper from the sheet feeder and reload up to 100 plain paper sheets (or up to 70 special 
coated sheets, or up to 30 sheets of oversized paper).

Paper is curled or folded.

 Use flat, non-damaged paper.

The paper may be too thick or too thin to feed properly.

 See your printer users guide for details on paper specifications.

The edge guides are not set correctly.

 Adjust the guides against the stack of paper.

Continuous paper may be left in the paper path.

 Remove the continuous paper.

The paper-release lever may be set to the wrong position.

 Set the paper-release lever to the single-sheet position.

The rear edge guide may not be located under the output tray.

 Move the rear edge guide under the output tray to match the paper loaded in the sheet feeder.

The rear edge guide does not match the length of index cards loaded.

 Position the rear edge guide as shown in your printer users guide.

Paper has been compressed and is sticking together.

 Fan your stack of paper before loading it in the sheet feeder.

You are printing on oversized paper, and the paper may be obstructed by the output tray. 

Raise the output tray by extending the legs under both sides of the tray to keep enough clearance 
between the output tray and paper support. See your printer users guide.

Paper may be jammed in the paper path.

 Turn off the printer and open the printer cover using the notch on the cover; then gently pull out the paper
by turning the knob toward you. Remove any remaining pieces of paper. See your Printer users guide.

Single sheets do not feed properly from the manual feed slot.



Paper is curled or folded.

 Use flat, non-damaged paper.

The paper may be too thick or too thin to feed properly.

 See your printer users guide for details on paper specifications.

Continuous paper may be left in the paper path.

 Remove the continuous paper.

The paper-release lever is set to the wrong position.

 Make sure that the paper-release lever is set to the single-sheet position.

Paper is not fed deeply enough.

Load a single sheet into the manual feed slot until it meets resistance.

The printer loads more than one sheet at a time.

Too many sheets are loaded in the sheet feeder.

 Take the paper stack out of the feeder, remove some sheets, and reload the stack. Before you load 
paper, see your printer users guide to check the amount of paper you can load in the sheet feeder.

Paper has been compressed and is sticking together.

 Fan your stack of paper before loading it in the sheet feeder.

The paper is too thin. 

 Make sure the paper meets the paper requirements for this printer.

Ejected paper is wrinkled. 

The paper is too thin or damp.

 Do not store your paper in a damp or humid environment. Store paper in its original packaging. 

Single sheets do not fully eject.

Paper gets stuck.

 Use the Load/Eject button to eject the page.

Page length setting is wrong.

 Check the page length setting in your application, and printer driver if necessary.



The paper may be too long.

 Use paper that is within the paper size limits. See your printer users guide for details on paper 
specifications.

Manual Feed Slot (Banner) is selected as the Paper Source setting in the printer driver.

 Make sure the correct Paper Source setting is selected in the printer driver.

The banner mode setting is set as the default setting.

 Make sure the banner mode setting is off. If this setting is on, the printer feeds paper a specified length. 
Change this setting using the default-setting mode. See your printer users guide.

Paper feeding is crooked.

The edge guide of the sheet feeder may not match the paper's width.

 Adjust the edge guides.

There may be too much paper in the sheet feeder.

 Remove some paper.

You are printing on oversized paper, and the paper may be obstructed by the output tray. 

 Raise the output tray by extending the legs under both sides of the tray to keep enough clearance 
between the output tray and paper support. See your printer users guide.

Paper is not fed deeply enough.

 Load a single sheet in the manual feed slot until it meets resistance.

The paper may be old or creased.

 Use only new, smooth sheets of paper.

Make sure that your paper is the proper size and quality.

 See your printer users guide for details on paper specifications.

Paper feed or paper jam problems occur frequently.

Sheets of paper are stuck together.

 Fan the stack of paper and tap it on a flat surface to align the edges before loading.

The paper is too thin or rough. 

 Make sure the paper meets the paper requirements for this printer.

Too many sheets are loaded in the sheet feeder.



 Check the paper package and your printer users guide for the amount of paper you can load in the sheet 
feeder.

The printable side of the paper is not correctly loaded.

 Try turning the stack of paper over in the sheet feeder. Most packages of paper indicate the printable side
with an arrow on the end of the package. Make sure the printable side is loaded face down in the sheet 
feeder.

Regular gaps occur in the printout.

The Skip-over-perforation setting may be on.

 Set skip-over-perforation to off in the default-setting mode. See your printer users guide.

The perforation of continuous paper is not aligned with the tear-off position.

The tear-off position is not properly set.

 Adjust the tear-off position using the micro-adjust feature. See your printer users guide.

The auto tear-off setting may be turned on in the default-setting mode.

 Turn this setting off. See your printer users guide.

The page length setting for continuous paper is not correct in the default-setting mode.

 Change the setting using the default-setting mode. See your printer users guide.

The tractor does not feed the paper.

The paper-release lever may be set to the wrong position.

 Move the paper-release lever to the continuous-paper position.

The paper has come off the tractor feeder.

 Reattach the paper to the tractor.

Paper feeding is crooked or the paper jams.

The paper supply is obstructed.

 Make sure the paper supply is not obstructed by a cable or some other object.

The paper supply is placed too far away from the printer.

 Make sure that your paper supply is positioned within 1 meter (about 3 feet) of the printer.



The holes on the sides of the paper are misaligned.

 Make sure that the holes on the sides of the paper are even with each other. Also, make sure the 
sprocket units are locked and their covers are closed.

The paper size or thickness is out of the paper specification limits.

 Make sure that the paper size and thickness are within the limits.

There may be some slack in the paper.

 Adjust the position of the sprocket units.

Continuous paper does not eject properly.

The page is too long.

 Tear off the last printed page and press the Load/Eject button to feed the paper backward. However, if 
you are printing on labels, tear off the last page that is entering the printer, then press the LF/FF button to 
feed paper forward.

The paper length is out of the specified length.

 Use paper that is within the specified length.

The page length setting for continuous paper in the default-setting mode is not correct.

 Change the page length setting for continuous paper in the default-setting mode.

The paper is jammed inside the printer.

Turn off the printer and open the printer cover using the notch on the cover; then gently pull out the paper 
by turning the knob toward you. Remove any remaining pieces of paper. See your printer users guide.

Caution: Use the knob on the left side of the printer only to clear paper jams and only when the printer is 
off. Otherwise, you may damage the printer or change the top-of-form position.



 Printing Quality
The printed image has gaps or faint areas.

The print head nozzles are clogged.

 Clean the print heads.

The paper quality has been reduced due to age.

 Use new paper.

The printer driver settings may not be correct.

 Select Automatic on the printer drivers Main menu and make sure the Media Type setting is appropriate 
for the type of paper loaded in the printer.

The printed image is blurred.

Your paper is moist or damp.

 Do not store your paper in a damp or humid environment. Store the paper in its original packaging.

The printer driver settings may not be correct.

 Select Automatic on the printer drivers Main menu and make sure the Media Type setting is appropriate 
for the type of paper loaded in the printer.

The printer drivers Ink setting is Color even though the printer is being used with an empty color ink 
cartridge installed.

Select Black as the Ink setting in your printer driver. Or, replace the color ink cartridge.

Printed image is smeared.

The paper you loaded is too thick.

 Open the printer cover and set the adjust lever to the + position.

Special paper was loaded without the support sheet or a regular sheet of paper under it. Glossy film, 
glossy paper, and transparencies should be loaded with the support sheet or a piece of plain paper under 
them.

 Load the support sheet or a piece of plain paper under the special paper.

Multiple sheets of EPSON Photo Quality Glossy Film are loaded.

 Load glossy film one sheet at a time with the loading support sheet or a piece of plain paper under it. If 
you need to load multiple sheets of glossy film, load only up to 30 sheets and set the top margin of the 
page to 30 mm or more.



Ink has leaked on the platen.

 Wipe the inside of the printer with a soft, clean cloth.

The print head nozzles are clogged. 

 Clean the print heads.

White horizontal lines appear through the text.

The print head nozzles are clogged. 

 Clean the print heads.

One of the ink cartridges is low on ink. 

 Check the control panel to confirm that one of the ink out lights is flashing, and replace the appropriate 
ink cartridge.

The MicroWeave option in your printer driver is not selected. 

 Turn on MicroWeave in your printer driver.

The Media Type setting in your printer driver is incorrect. 

 Make sure the Media Type setting matches the type of paper loaded in the printer.

Vertical or horizontal printed lines do not align. Or, white banding appears between color and 
black graphics. 

The print heads are misaligned.

 Align the print heads with the Print Head Alignment utility.

The printing position is misaligned.

 Make sure the High Speed option in your printer driver is not selected.

Printing quality is not what you expect.

The paper loaded is not the paper selected in your application or the printer driver.

 Make sure you loaded the correct paper in the printer and that you selected the same media type in your 
application and/or the printer driver. Make sure you are using paper that meets the paper requirements for
this printer.

You are not printing on the correct side of the paper.

 Check the paper packaging for the correct side for printing; then load the printable side of the paper face 
down in the sheet feeder. When using the manual feed slot or tractor feeder, load paper printable side up.



The printer driver settings are not correct.

 Check the printer driver settings to make sure they are appropriate. If these settings are correct, check 
your application, because some application settings override driver settings. 

The High Speed setting is selected in the printer driver.

To obtain higher quality output, make sure High Speed is not selected.

Colors are different than you expect.

The color print head nozzles are clogged.

 Clean the print heads.

Black ink is selected in your printer driver.

 Set the Ink setting to Color.

You are not printing on the correct side of the paper.

 Check the paper packaging for the correct side for printing, then load the paper correctly.

The Media Type setting does not match the type of paper loaded in the printer.

 Change the Media Type setting in your printer driver to match the type of media you have loaded. Load 
media that matches the Media Type setting you selected in the printer driver

The ICM setting in your driver is not appropriate for your document.

 Set the driver to Automatic.

Your printer and monitor are not properly calibrated for color matching.

See the users guides of your image-editing software and your monitor for information on calibrating your 
system for color matching.

Colors are not very vibrant.

The image was printed on the wrong side of EPSON Ink Jet Paper.

 Make sure that you are printing on the coated side of the paper. If necessary, flip over the paper and try 
printing again. If printing does not improve, clean the print heads.

The Media Type setting on the Main menu does not match the type of paper loaded in the printer. 

 Change the Media Type setting in your printer driver to match the type of media you have loaded, or load
media that matches the Media Type setting.

Color dots are missing in printed characters or graphics. The printed color image has gaps or 



faint areas.

The color print head nozzles are clogged.

 Clean the print heads.

Black dots are missing in printed characters or graphics. The printed black image has gaps or 
faint areas.

The black print head nozzles are clogged.

Clean the print heads.

Photographic images look grainy or rough.

The printing position is misaligned.

Align the print heads. 

The resolution of the original image data or the resolution setting for the image in your image-editing 
software may be too low.

Increase the image resolution in your image-editing software. Keep in mind that higher resolution images 
take longer to print.

You cleaned the print heads using the Head Cleaning utility, the output quality has not improved.

You attempted to clean the print heads while the ink cartridges were low or out of ink.

 Check the black or color ink out light. When the ink cartridges are low or out, the Head Cleaning utility 
has no effect. Replace the ink cartridges as needed.




